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Abstract
In this paper, we have conducted an eye tracking experi-
ment by employing an inexpensive, lightweight, and portable
eye tracker paired with a tablet. Students were instructed to
solve the physics problems by presenting them three co-
herent representations about a phenomenon: Vectorial
representations, data tables and diagrams. The effective-
ness of each representation was assessed for three levels
of student expertise (experts, intermediates and novices)
using entropy-based transition analysis of the gaze data.
The results show that students of different skill level (a) pre-
fer different representations for problem-solving, (b) switch
between representations with different frequencies, and (c)
can be distinguished by the density of representation use.
The obtained results confirm earlier findings of physics ed-
ucation research quantitatively which were initially obtained
by student interviews and observational studies.
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Introduction
Students’ competence in using different representational
formats and transfer one in another; so-called represen-
tational competence, is a popular topic in current science
education. Recent research projects in mathematics and
physics education paid a lot of attention to study students’
competence with different representational formats [10].
It has been shown that a competent handling of Multiple
Representations (MR) is linked with domain expertise and
serves as a basis for gaining deep, robust and flexible con-
ceptual understanding of the underlying physics domain [11] [12].
Competent handling of MRs includes the interpretation of
single representations, switching between representations,
and making choices among representations. The insight
about this competence is interesting for instructors to in-
crease the quality of education. In addition, authors and
publishers could gain insight from this information to pub-
lish adaptive physics books appropriate for different level of
student expertise and for variety type of problems.

Figure 1: The experimental setup
with SMI Scientific REDn
accompanied by Microsoft Surface
Pro3.

Many works have been already done in Physics Educa-
tion Research on students’ representational skills including
[3] [5] [4] [6] [7]. These studies ask what students know
about representations, and how that knowledge might affect
students’ performance [12]. However, there are only a few
studies which compare students’ attention to representation
while solving the problem. Some studies highlighted differ-
ences between problem-solving approaches of experts and
novices, with some of these differences involving represen-
tation use [13].
It has been argued that different isomorphic representa-
tions of a common formal structure can cause dramatically
different cognitive behaviours (so-called accidentRepresen-
tational Effect [15]). With respect to this, eye tracking as a
method may provide useful insights into the student compe-
tence with different representational formats [14] as it may
reveal whether correct solutions can be triggered by partic-

ular details of the representation and dependent on the type
of the problem.
In this paper, we employ a mobile remote system for our
study in an educational environment. Inline towards the
goals of our previous works [1][2], in order to use mobile,
flexible and inexpensive eye tracking systems, we employed
a mobile remote system in our study in an educational en-
vironment. Such systems are suitable for eye movement
researches in the real-world scenarios.
The line of research in which the current study fits focuses
on the relationship between student success and the rep-
resentational format they chose when they are confronted
with a multitude of representations. Beyond the theoretical
contribution of this research to the fields of representations
and cognition, it has practical implications for designing in-
structional representations that support the development
of conceptual understanding. In order to achieve this goal,
we are trying to answer the following two questions in this
paper: Do experts use different representations to solve a
problem compared to novices? Do experts use more com-
pressed representations compared to novices?

Methodology
This section briefly explains the entropy based transition
analysis of eye movements between different representa-
tions (table, vector, and diagram) during physics problem
solving with the help of representations that have already
have been discussed in the previous section. Entropy is a
measure in information theory to describe the information
in a variable in terms of ordering. This measure is called
Shannon entropy and it is defined as:

H(R) = −
∑

p(ri) log2(ri), ri > 0 (1)

where H(R) is the entropy in bits and p(ri) is the propor-
tion of measurement ri.



Figure 2: The experiment was constructed with two sets of
questions. Each set contains 5 questions with corresponding
answer sheets. This figure shows the first question of the first set.

Transition Matrix Entropy
Entropy can be calculated for a transition matrix[8]. The
lowest possible value is zero (0) when there is no uncer-
tainity about what type of transition will occur. The max-
imum value for entropy is when all the cells in the transi-
tion matrix carry different values. For example, for a tran-
sition matrix with six cells, the maximum value would be
−6 1

6 log2(
1
6 ), which equals to 2.59 bits. Bits is not an intu-

itive unit, however, by dividing H(R) by the maximum value
of the entropy (2.59 in our case) we gain the normalized
entropy that allows to make comparisons of results across
groups and stimuli[8].

Scan Path Entropy
In order to calculate scan path entropy, the AOI (Area of
Interest) string must be generated. According to [9] we fol-
lowed these steps:

1. Choose a target AOI. Text, table, vector and diagram.

2. Transform each scan path into a character string.
Each character refers to a fixation in a specific AOI.

3. Remove all repetitions. "AAABCDDT" becomes "ABCDT".
In fact, this is going from a fixation-based represen-
tation to a dwell based representation [8]. A dwell
consists of one or more fixation within one AOI.

4. Remove repetitions of two characters ("ABABCDT"
becomes "ABCDT"). This is removing re-fixations
from a pre-planned path. Re-fixations may occur if
the previous fixation was too short to allow for visual
analysis and occur during search, reading and free
viewing. These re-fixations have been removred be-
cause they originate from timing errors in oculomotor
control, not from choosing an ineffective path.

5. Count the number of unique scan paths.

6. Construct a histogram of the unique scan paths and
their frequency.

7. Apply the entropy formula to compute entropy.

Experiment Setup
In this section, we explain the eye tracking system that has
been used in this study and the procedure applied to con-
duct the experiment for this study.



Remote Mobile Eye Tracking systems
The emergence of lightweight and portable eye trackers
paved a new path for the researcher to acquire and ana-
lyze data in real-world environments such as psychothera-
pists’ clinics, hospitals and classrooms. With respect to the
importance of mobility and flexibility, we prefered the Sen-
soMotoric Instrument iView X REDn scientific eye tracker
operating at 60Hz in order to carry out our study. The track-
ing error reported by the manufacturer was less than 0.4
degree, which makes it appropriate for fixation based eye
movement studies. The eye tracker was paired with Mi-
crosoft Surface PRO recommended by the eye tracker man-
ufacturer. Post processing was conducted by the custom
software written in Python. Figure 1 shows our experimen-
tal setup.

Procedure
The instructional material were physical problems (Prob-
lem 1: trajectory / air resistance; Problem 2: the arbitrary
motion of a sphere), for which ten questions had to be an-
swered as either true or false. In order to solve the problem
and answer the questions correctly, three isomorphic rep-
resentations were displayed. The three representations are
equal within each problem and capture the information to
solve the question. The representations appeared always
on the same place on the screen. Before starting the ex-
periment the student’s familiarity is assessed with each kind
of representation was assessed using 13 Likert-type items
(Cronbach’s alpha = .94). Moreover, students had to judge
their experience with motion processes. Both information
were combined to define expertise levels.
The experiment is designed in two eye tracking phases cor-
responding to the two selected problem sets. The process-
ing of the phases is equivalent. First, participants are asked
to sit 60 cm away from the tablet to perform 9-point calibra-
tion and validation of the eye tracker. Each problem con-

Figure 3: The procedure of the experiment.

tains five questions. The first question with three represen-
tations namely table, vector and diagram, is shown in Fig-
ure 2. In this step, the eye tracking server starts to record
the gaze. Only after the participants finished reading the
question, the answering page loads in order to answer the
question while the user’s gaze is recording. This process
is repeated for all question. Eye gaze information for each
question page and the answering page was saved sepa-
rately for further analysis. Figure 2 shows the first question
of the first set of problems on the top while the bottom indi-
cates the corresponding answering page. The flowchart of
the experimental process is shown in Figure 3.



Results
Table 1 summarizes the statistics of four measures for
users of different expertise levels. Our evaluation is four-
fold: Firstly, we calculated the accumulative heat maps of
each expertise group and found the difference between
novices and experts. Figure 4 shows appropriate heat
maps for novices, intermediates and experts respectively.
For novices, the heat map indicates that they had most of
their fixations on the question itself. In contrast, expert’s
gaze is concentraiting on the representations. It indicates
they have less struggling with the comprehension of the
questions compared to intermediate and novices.

Figure 4: Accumulative heat maps
for novices, intermediates and
experts. For novices, the heat map
indicates they have most of their
fixations on the question itself. In
contrast, experts have most of their
fixations on the representations. It
indicates they have less struggling
with comprehension of the
questions compared to
intermediates and novices.

We found out the vector representation was used at least
among all expertise levels. Secondly, we analyzed the gaze
data with respect to shifting the focus among representa-
tions in a given problem. If a participant spent more than
80% of the time on one single representation ’A’, we as-
sume that he did not consider any other representation than
’A’ to solve the question. In about 9 of 10 times, novices
switched between at least two representations before giv-
ing an answer, whereas experts did so only in about 75% of
the setup. Thirdly, we have calculated the ratio of represen-
tation gaze to (text gaze + representation gaze) for every
expertise level. We refer to this as the density of represen-
tation use. As a fourth finding, we evaluated the confidence
score, which reflect that experts are both more efficient and
more confident than novices, i.e. the confidence scores dif-
ferentiate between the expertise levels.
As it turned out that the problems were quite simple (overall
solution probability was 0.9), we analyzed the hardest ques-
tion of our setting in more details. The evaluation shows
that it was solved correctly only by 11 out of 15 users (73%)
responding with a confidence score of 76%. To answer this
question, there were five students who used only one sin-
gle representation and they all answered it correctly (three

Figure 5: Scan path entropy for the three levels of expertise.
Novices tend to switch much more between representations,
hence their entropy is larger.

used only the diagram, and two used only the data table).
The representation they have used in this particular ques-
tion was also their favorite representation in most cases
and the representation they felt most familiar with accord-
ing to their familiarity estimate. Table 2 shows Step-by-step
entropy calculations for the transition matrices of the three
classes of expertise. The entropy of transition for experts,
intermediates and novices are 1.950, 1.997, 2061 bits with
normalized entropy of 0.7528, 0.771, 0.7958 respectively.

Figure 5 shows scan path entropy of experts, intermediates



Table 1: Statistics of four measures for different expertise levels. N is the number of participants in the corresponding categories Experts,
Intermediates and Novices. P represents the score out of 10. The number in the parentheses are standard error of the estimate.

Expertise Level N P
Representation Used

Only Single Representation Used Density Confidence Level
Vector Table Diagram

Expert 7 10 17.90% 40.8% 41.4% 24%(5.3%) 48%(7%) 95%(3%)
Intermediate 5 9.5 23% 38% 39% 20%(8.3%) 36%(3%) 88%(4%)

Novice 3 7 22.8% 50.9% 26.3% 10%(5.8%) 35%(8%) 84%(6%)

and novices. Novices tend to switch much more between
representations, hence their entropy is larger. This is con-
firmed by the data: The more expertise, the less switching
occurs.

Discussion
There is a tension between designing representations best
suitable to foster learning and understanding, on the one
hand, and the careful analysis of the complex cognitive
mechanisms of their use and interpretation accounting for
student’s diversity of conceptual resources, on the other
hand. The present contribution here is preliminary, but yet
suggests some crucial differences between expert and
novice problem solvers.
We were surprised to find that novices were just as likely
to use multiple representations as experts and that they
moved more often between them. By doing so, they may
be hoped to strike a hint leading to a correct approach. Ex-
perts, in contrast, proceeded more systematically and stuck
to one single representation. Their representation use is
more compressed. Especially when they were confronted
with a hard question, they focused on the representation
they are most familiar with and solved it correctly. Experts
are more confident in their response reflecting some meta-
cognitive awareness respecting their problem-solving strat-
egy. They tend not only to use the representation more pur-
posive than novices but also know why they do so. Con-

cerning specific representations, we found that novices
used the diagram significantly less often than experts and
preferred the numerical representation (table). It is obvious
that diagrams are more difficult to be interpreted correctly
compared to numerical values and that an appropriate un-
derstanding of kinematic graphs is a key to succeeding in
scientific problem-solving. Avoiding diagrams and restricting
oneself to numerical representations reflects a behavior of
novices that have been experienced in other studies. Our
gaze data support these findings quantitatively.
For the scan path entropy results from an educational per-
spective, this makes sense because novices hunt for infor-
mation, they browse through the representation aimlessly.
In contrast, experts know where to look and hence their en-
tropy is smaller.

Conclusion
In this paper, the study of representational competence in
physics education research with a tablet eye tracking sys-
tem has been presented. Due to the environment of the
research, this type of eye tracking systems is much more
appropriate. For three levels of student expertise: experts,
intermediates and novices the effectiveness of each rep-
resentation was studied. The results confirm that students
prefer different representations depending on their skill level
leading to direct implications for physics education. The
novices struggle with representations more than experts to



Table 2: Step-by-step entropy calculations for the transition matrices of experts, intermediates and novices

Novices Intermediates Experts
Transition p(ri) log2p(ri) p(ri)log2p(ri) p(ri) log2p(ri) p(ri)log2p(ri) p(ri) log2p(ri) p(ri)log2p(ri)
Vector→Table 0.3 -1.736 -0.521 0.37 -1.434 -0.531 0.44 -1.184 -0.521
Vector→Diagram 0.59 -0.761 -0.449 0.49 -1.029 -0.504 0.62 -0.689 -0.427
Diagram→Table 0.95 -0.074 -0.070 0.93 -0.105 -0.097 0.9 -0.152 -0.137
Diagram→Vector 0.89 -0.168 -0.149 0.83 -0.269 -0.223 0.66 -0.599 -0.396
Table→Diagram 0.81 -0.304 -0.246 0.87 -0.201 -0.174 0.78 -0.358 -0.279
Table→Vector 0.46 -1.12 -0.515 0.56 -0.837 -0.468 0.76 -0.396 -0.301

hunt the information. In future work, we have to consider
the purpose behind the use of the available representations
with more details.
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